2D/3D Converter Software
Version 1.00

MPES-2D3D1
Help

© 2010 Sony Corporation
# Table of Contents

- **Overview** ...................................................................................................................................... 4
- **2D/3D Converter Software Features** ........................................................................................ 5
- **System Configuration Example** .................................................................................................... 6
- **Screen Organization** ...................................................................................................................... 7
  - Menu Bar ........................................................................................................................................... 7
  - Status Display Area .............................................................................................................................. 8
  - Input select buttons ............................................................................................................................ 8
  - [Lock] Checkbox ................................................................................................................................... 8
  - [System Setup] button .......................................................................................................................... 8
  - Control Block ..................................................................................................................................... 8
- **Preparations** ..................................................................................................................................... 9
- **Preparation Procedure** .................................................................................................................. 10
- **Connecting** .................................................................................................................................... 11
- **Preparing the MPE-200 Unit** ........................................................................................................ 12
  - Advance Preparations ......................................................................................................................... 12
    - Usage environment ............................................................................................................................ 12
    - Terminal settings ............................................................................................................................... 12
    - To establish communication .............................................................................................................. 12
  - Logging In .......................................................................................................................................... 12
  - Setting the Time Zone ......................................................................................................................... 13
  - Setting the Clock ................................................................................................................................. 13
  - Setting Up the Network ....................................................................................................................... 14
  - Installing Software on the MPE-200 unit ............................................................................................ 14
  - Selecting the Software ......................................................................................................................... 15
  - Completing Settings ............................................................................................................................ 15
- **Starting the 2D/3D Converter Software** ....................................................................................... 16
- **Making Default Settings** ............................................................................................................ 17
  - Setting Procedure ............................................................................................................................... 17
  - Setting Up the [System Setup] Menu ................................................................................................. 18
- **Operating Procedures** .................................................................................................................... 19
- **Conversion Settings** ..................................................................................................................... 20
  - Selecting the Input ............................................................................................................................... 20
  - Adjusting Depth Perception for a Part of the Image ............................................................................ 21
  - Adjusting Overall Image Depth Perception ....................................................................................... 21
  - Specifying the Display Method for the Monitor Image ...................................................................... 21
  - Saving Settings .................................................................................................................................. 21
  - Loading Settings .................................................................................................................................. 22
- **Appendix** ...................................................................................................................................... 23
- **How to Use this Help** ..................................................................................................................... 24
Overview

The following items should be understood when using the 2D/3D Converter Software.

- 2D/3D Converter Software Features
- System Configuration Example
- Screen Organization
2D/3D Converter Software Features

The 2D/3D Converter Software converts 2D images to 3D through the MPE-200 Multi Image Processor. 2D images input from video devices connected to the MPE-200 are converted according to specified parameters. Conversion processing by Sony's proprietary software produces natural-looking 3D images with minimal faults.

- Conversion parameters can be adjusted from the computer connected to the MPE-200. This makes it possible to adjust 3D image conversion to suit a variety of purposes.
- Up to four input signal lines are available, one of which can be switched to output.
- The output image can be confirmed on monitors connected to the MPE-200. Three image monitoring display methods, such as side-by-side, can be selected.
- This software supports connection of up to six MPE-200 units.
- The following signal formats are supported.
  1080i/59.94, 1080i/50, 1080PsF/23.98, 720P/59.94

The MPES-2D3D1 Package includes the following software.

- MPES-2D3D1 application software for the MPE-200 unit (for installation on the MPE-200 unit)
- MPES-2D3D1 application software for the computer (for installation on the computer)
System Configuration Example

The following system configuration diagram shows how the 2D/3D Converter Software is used.

Input Video Devices
(Camera, VTR, etc.)

2D image inputs (Up to 4 lines)

MPES-2D3D1 application software for the MPE-200 unit

Computer

Ethernet Connection

Output Video Devices
(Switcher, VTR, etc)

Select 1 of 4 inputs for conversion and output as a 3D image

IN 1~4

OUT 1 (L)

OUT 2 (R)

OUT 3

MPE-200 Multi Image Processor

Monitor Output

Monitor
Screen Organization

Menu Bar
The menu is used to operate the software. Click the menu items to display commands to execute the program functions.

[File] menu
Click to open the [File] menu. The menu contains the following commands.

- [Exit]
  Closes the program.

[Help] menu
Click to open the [Help] menu. The menu contains the following commands.

- [Help]
  Displays this help.
- [About 2D/3D Converter]
  Displays the software version information.

(The screen displayed may differ in appearance from this example.)
Status Display Area
Displays the status of the connected MPE-200 as follows.

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stopped</td>
<td>Stopping</td>
</tr>
<tr>
<td>Initializing</td>
<td>Initializing</td>
</tr>
<tr>
<td>Ready</td>
<td>The program is running</td>
</tr>
</tbody>
</table>

Input select buttons
Four buttons labeled [1] to [4] are provided, corresponding to MPE-200 input slot connectors 1 to 4. Clicking any of these buttons displays conversion parameters for the corresponding input in the control block. See "Conversion Settings" for details.

[Lock] Checkbox
Selecting this checkbox grays out and disables selection of all channel buttons, except the button for the currently displayed channel. Use this to avoid changing the input image by inadvertently clicking the input select buttons.

[System Setup] button
Displays the default settings for this program in the control block. See "Starting the 2D/3D Converter Software" for details.

Control Block
Displays the [System Setup] menu or the conversion settings screen for each input.
Preparations

This section describes the preparations necessary to use the 2D/3D Converter Software. Refer to "Preparation Procedure" to prepare the following items in order.

- Preparation Procedure
- Connecting
  - Preparing the MPE-200 Unit
    - Advance Preparations
    - Logging In
    - Setting the Time Zone
    - Setting the Clock
    - Setting Up the Network
    - Installing Software on the MPE-200 unit
    - Selecting the Software
    - Completing Settings
- Starting the 2D/3D Converter Software
- Making Default Settings
  - Setting Procedure
  - Setting Up the [System Setup] Menu
Preparation Procedure

Step 1 Preparing the Computer
See "Read This First" for details.

Step 2 Save the MPES-2D3D1 Package
See "Read This First" for details.

Step 3 Run the MPES-2D3D1 Package
See "Read This First" for details.

Step 4 Connecting

Step 5 Preparing the MPE-200 unit

Step 6 Starting the 2D/3D Converter Software
Connecting

Connect the computer and the input and output video devices to the MPE-200.

1. Prepare the computer that will be directly connected to the MPE-200 by Ethernet. See "Read This First" for the computer requirements.
2. Connect the computer to the NETWORK-1 connector on the MPE-200 unit via the LAN.
3. Connect the input video devices to MPE-200 IN connectors 1 to 4.
4. Connect MPE-200 OUT connectors 1 and 2 to the output video devices. Connect the left side display to OUT connector 1, and connect the right side display to OUT connector 2.
5. If necessary, connect the display monitor to OUT connector 3.
6. If an external synchronization signal is necessary, connect the genlock signal to the REF IN connector.
Preparing the MPE-200 Unit

- Advance Preparations
- Logging In
- Setting the Time Zone
- Setting the Clock
- Setting Up the Network
- Installing Software on the MPE-200 unit
- Selecting the Software
- Completing Settings

Advance Preparations

Check your usage environment, and establish communication using the terminal software.

Usage environment

RS-232C parameters:

<table>
<thead>
<tr>
<th>Serial port setting</th>
<th>Setting value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>38,400 baud</td>
</tr>
<tr>
<td>Data word length</td>
<td>8 bit</td>
</tr>
<tr>
<td>Parity bit</td>
<td>No</td>
</tr>
<tr>
<td>Stop bits</td>
<td>1 bit</td>
</tr>
<tr>
<td>Flow control</td>
<td>No</td>
</tr>
</tbody>
</table>

Terminal settings

VT100 type, 80 character x 24 lines or more

To establish communication

Confirm that ";syscon;" appears on the terminal software.
Press the Esc key on the keyboard, and then press the Shift + C keys within 1 second. Next, press the Enter key a few times. "localhost login:" will appear, and communication will start.

Logging In

To configure settings, log in to the MPE-200 unit using a maintenance user account.

Maintenance User Account Information:

username: setup
password: sjx-311

After login, the management software starts up automatically, and the initial screen appears on the console.

The following four items displayed on the initial screen are not used when installing this software:

- Application uninstall
- Factory Setting
- Platform update (may appear as "Management Utility update" depending on the software environment of the MPE-200)
- Log files collection

For details on these functions, please contact a Sony service representative or dealer.

**Setting the Time Zone**

Sets the time zone.
This example describes how to set Japan time.

1. On the initial screen, select "1."
tzselect starts up.
2. Select "5) Asia" from the region selections.
3. Select "19) Japan" from the country selections.
The following information appears.

4. Verify that the setting is correct, and select "1) Yes."
   When the setting is complete, the initial screen appears again.

**Setting the Clock**

The internal clock of the MPE-200 unit is set at the factory, but you can change the setting as follows if necessary.

1. On the initial screen, select "2."
The current date and time are displayed as follows.

2. Enter the date and time using the same format as above.

   A confirmation message appears.
3. Enter "y" and press the Enter key.

   Tip: If you press the Enter key without any other input, the following screen appears. To redo input, enter "n."

   When the setting is complete, the initial screen reappears.
Setting Up the Network

Making network device settings.
"eth0" refers to the NETWORK-1 connector on the rear of the MPE-200 unit.
"eth1" refers to the NETWORK-2 connector on the rear of the MPE-200 unit.

1. On the initial screen, select "3."
2. Configure network device settings as follows.
   Example: To set "eth0" to "192.168.1.100",
   (1) Select eth0.
   Use the arrow keys to move the cursor to "eth0" and press the Enter key.
   (2) Make eth0 setting.
   Enter the fixed IP address in the "Static IP" field, and enter the netmask in the "Netmask" field.
   Configure the other settings as needed.
   (3) Use the arrow keys to move the cursor to "OK," and press the Enter key.

When the setting is complete, the initial screen reappears.
3. Reboot the MPE-200 unit.
   See "Completing Settings" for details.

Installing Software on the MPE-200 unit

Copy the application's installation package to a USB flash drive, and insert it in the MPE-200 unit.
The software automatically starts and stops when the MPE-200 unit is turned on and off.

The installation package creates the following files and folders when unzipping MPES-2D3D1_****_install_package.zip.
Depending on the software version, the file names and number of files may vary.

- MPES-2D3D1_****_***.ppc64.rpm
- ftplib_***_***.ppc64.rpm
- repodata (folder)
- GUI (folder)
Note
If multiple USB flash drives are connected to the MPE-200 unit, installation will not be performed correctly. Remove any other USB flash drives from the MPE-200 unit.

1. Unzip the installation package, copy all files and folders to the root directory (topmost folder) of the USB flash drive, and then insert it into the MPE-200 unit.
2. On the initial screen, select "5."
3. Select '1. MPES-2D3D1 "Sony 2D/3D Converter software" *****.'
   A confirmation message appears.
   
   Are you sure[yes/[n]o]?

4. Enter "y" and press the Enter key.
5. Enter the installation key that is provided with the installation package you acquired, and press the Enter key.
   
   Input the installation key code: _

   The installation key consists of 16 alphanumeric characters.
   A confirmation message appears.
6. Enter "y" and press the Enter key.
   Installation starts.
   When installation is complete, the initial screen appears again.
7. Disconnect the USB flash drive.

Selecting the Software

1. On the initial screen, select "9."
   The installed applications appear.
2. Select the number for MPES-2D3D1.
   A confirmation message appears.
3. Press [y].

Completing Settings

1. On the initial screen, select "q."
   The Quit screen appears.
2. On the Quit screen, select "r."

   r: Quit and Reboot

   The settings are applied, and the MPE-200 unit reboots.
Starting the 2D/3D Converter Software

1. Double-click the 2D/3D Converter Software icon on the desktop. The [New Connection IP Address] dialog box appears.

2. Specify the IP address of the MPE-200.
   Tip
   The IP address specified here will subsequently be displayed in the [History] list. After restarting, you can click [History] and select an IP address from this list for connecting to the MPE-200.

3. Click [OK].
   The program's main screen appears.
   When launching the program the first time, configure the default settings using the [System Setup] menu. See "Making Default Settings" for details.
Making Default Settings

- Setting Procedure
- Setting Up the [System Setup] Menu

Setting Procedure

When starting the program for the first time, make default settings from the [System Setup] menu on the main screen. After making the settings, restart the program.

1. Click the [System Setup] button. The [System Setup] menu appears.
   - Tip Changes to settings are not applied until you click [Apply Setup Data]. After changing settings, switching to another menu (besides the [System Setup] menu) cancels the changes, and settings revert to those in effect when the program was started.
3. Click [Apply Setup Data]. A message appears asking for restart confirmation.
4. Click [Yes]. Settings on the [System Setup] menu are applied to the MPE-200, and the program restarts.
   - Tip When [Save User Data] is enabled and you click [Yes], setting values are saved as user data when the program restarts.
Setting Up the [System Setup] Menu

- **Signal Format**
  Sets the system mode.
- **Gen. Lock**
  Specifies the image signal sync source.
  - **External Ref.**
    Synchronizes on the image signal input through the REF IN connector on the rear of the MPE-200.
  - **HD SDI (Input 1)**
    Synchronizes on the image signal input through IN slot connector 1 on the rear of the MPE-200.
- **Start Up**
  Selects what settings are to be loaded by the program upon startup.
  - **Default:** Loads the default settings.
  - **User:** Loads settings saved by the user.
- **Apply Setup Data**
  Applies the settings, and then restarts the program.
Operating Procedures

This section describes the parameter settings for converting 2D images to 3D. It also describes how to save setting values as user data.

- Conversion Settings
  - Selecting the Input
  - Adjusting Depth Perception for a Part of the Image
  - Adjusting Overall Image Depth Perception
  - Specifying the Display Method for the Monitor Image
  - Saving Settings
  - Loading Settings
Conversion Settings

- Selecting the Input
- Adjusting Depth Perception for a Part of the Image
- Adjusting Overall Image Depth Perception
- Specifying the Display Method for the Monitor Image
- Saving Settings
- Loading Settings

Selecting the Input

Select one of up to four input signals connected to the MPE-200 and set 3D image conversion parameters.

1. Click the input select button with the number, [1] to [4], that corresponds to the input video device connected to the MPE-200.
   The conversion settings are displayed in the control block.

![Conversion Settings Interface](image-url)
Adjusting Depth Perception for a Part of the Image

To adjust depth perception for the plane of focus, select the [Local Depth] checkbox and adjust the following parameters.

<table>
<thead>
<tr>
<th>Item</th>
<th>Range</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain</td>
<td>0 - 15</td>
<td>0</td>
<td>Adjust the degree of enhancement of the plane of focus, from 0 to 15.</td>
</tr>
<tr>
<td>Near - Far</td>
<td>0 - 15</td>
<td>7</td>
<td>Adjust the focus ratio between the plane of focus (in the foreground) and the unfocused region (in the background), from 0 to 15. Dragging the slider to the [Near] side brings the plane of focus forward. Dragging the slider to the [Far] side moves the unfocused portion forward.</td>
</tr>
</tbody>
</table>

If ringing appears in the image as a result of [Gain] and [Near - Far] adjustments, it can be suppressed by selecting the [Low Pass Filter] checkbox.

Adjusting Overall Image Depth Perception

To adjust depth perception the overall image, select the [Global Depth] checkbox and adjust the following parameters.

<table>
<thead>
<tr>
<th>Item</th>
<th>Range</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inter-axial Distance</td>
<td>0.0 cm - 20.0 cm</td>
<td>6.5</td>
<td>Adjust the interocular distance of the left and right images composing the 3D image.</td>
</tr>
</tbody>
</table>

Note

With Global Depth, the left and right images are enlarged slightly in the horizontal dimension to enhance perspective. Depending on the [Inter-axial Distance] setting, this may cause the left and right edges of input images to appear clipped.

Specifying the Display Method for the Monitor Image

Use [Monitor Out] to select the monitor display method for 3D images.

- Side by Side
  Outputs the L and R image signals to the left and right halves of the screen, respectively. Each image is horizontally compressed to 1/2 normal size.
- L/R Mix
  Outputs the sum of 50% of each of the L and R image signals.
- Anaglyph
  Outputs a binocular image for viewing with red/blue filter glasses.

Saving Settings

Conversion settings can be saved as user data.
Only one set of user data can be saved. Multiple sets of user data cannot be saved.

1. Click [Save User Data].
   The settings are saved as user data.
Loading Settings

Use [Setup Recall] to load the program's factory default settings or settings that have been saved by the user.

- Default
  Loads the default settings.
- User
  Load settings saved as user data. See "Saving Settings" for how to save settings.
Appendix

The following items are included in this section.

- How to Use this Help
- NOTICE TO USERS
- Trademarks
How to Use this Help

Starting the Help
Select [Help] from the [Help] menu.

Help Window Configuration
The Help window consists of the following items.

Tab buttons
Switches between navigation component displays using the following buttons.

- Contents button
  Displays the topics of this Help. Click a topic title to display the topic in the topic area.
- Index button
  Displays the indexed keywords of this Help. Click a keyword to display topics related to that keyword.
- Search button
  Displays the search tab for searching words within this Help. The search results display related topics in order of relevance.
  You can enable [Highlight search results] to highlight all instances of the search word in the topic area.

Search box
Enter text to search for words in the Help. Related topics are displayed in order of relevance in the Search tab.
Search results are identical to those obtained using the Search tab button.
Contents, Index, and Search tabs (navigation component)
Displays the Contents, Index, and Search tabs of this Help.
Click the ← button at the upper left to display the previous topic, and click the ➔ button to display the next topic.
Click the ✗ button at the upper right to hide the Contents, Index, and Search tabs, and click the Contents, Index, or Search button to redisplay it.

Topic area
Displays the selected topic.
The current topic's location in the Help is displayed at the upper right.
NOTICE TO USERS

Documentation © 2010 Sony Corporation
All rights reserved. This manual or the software described herein, in whole or in part, may not be reproduced, translated or reduced to any machine readable form without prior written approval from Sony Corporation.

SONY CORPORATION PROVIDES NO WARRANTY WITH REGARD TO THIS MANUAL, THE SOFTWARE OR OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD TO THIS MANUAL, THE SOFTWARE OR SUCH OTHER INFORMATION. IN NO EVENT SHALL SONY CORPORATION BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES, WHETHER BASED ON TORT, CONTRACT, OR OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL, THE SOFTWARE OR OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. Sony Corporation reserves the right to make any modification to this manual or the information contained herein at any time without notice.
The software described herein may also be governed by the terms of a separate user license agreement.

Disclaimers

Original images will change in appearance after performing image conversion with this product. Therefore, to prevent copyright infringement on copyrighted material, obtain the proper permissions from the copyright holder of the original images before conversion.
Trademarks

All product names and brand names are registered trademarks or trademarks of their respective owners. Further, the ® or ™ symbols are not used in the text.